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Convert WebM format videos to MP4 with VLC,
Handbrake and online conversion tools

Do you want to convert WebM format files to MP4? Although this open source format is commonly found on
HTML5 sites like YouTube, some video players do not support WebM videos. Luckily, converting videos with
the .webm extension to MP4 is simple and doesn't take much time. If you want to create an MP4 video with the
same resolution and capacity as the original file, you can use any video conversion program, including VLC
Media Player, or an online tool available on any platform. If you're looking for a simple way to reduce video
quality and size, try HandBrake on your Windows or Mac computer. This is an article showing 5 simple ways to
help you convert WebM format videos to MP4.

Use Veed.io (on any platform)

Visit https://www.veed.io/convert/webm-to-mp4 in your browser. This is one of the online conversion tools
that help you easily convert WebM format files to MP4. You can use this tool on any platform, including your
computer, Android device, iPhone or iPad.

This is a great solution if you want to quickly convert WebM format files to MP4 without changing the results.
You can even use this tool on Android, iPhone or iPad.

The free Veed.io service package allows users to convert videos with a maximum capacity of 250MB. Maximum
export duration is 10 minutes. Additionally, the video also has a blurred icon. So, if you convert WebM to MP4
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online using Veed.io, you need to remove the watermark manually. Or, you can subscribe to Veed.io for a
premium subscription to convert online videos without the watermark.

Although Veed.io allows you to convert larger files than most other online tools, it may not be the best choice if
the WebM file is large - file uploading Large volumes can be time-consuming. If the WebM file is very large, it
is better to use an online tool like VLC or Handbrake.

Click Upload Your File . This opens a file browser window.

Select file. Select the ".webm" file extension, then select Open or Upload when prompted. This is the operation
of uploading WebM files to Veed.io.



Click Convert File . This is the big oval button at the bottom of the page. You will see a preview after the file is
converted.

Click Download MP4 . The file is immediately downloaded to the default library of your computer, phone or
tablet.

You may have to tap Save to save the file.

Use Handbrake (on Windows and Mac)



Open Handbrake on your Windows or Mac computer. Handbrake is an open source video conversion
program that helps you easily convert WebM format files to MP4. If you don't have Handbrake, you can
download the program from https://handbrake.fr.

Handbrake has many built-in settings that help you easily change the quality and ratio of MP4 files. Although
you can't really improve the quality of low-quality videos with Handbrake, you can use this program to create
smaller files that make it easier to share.

Drag and drop the WebM file into the window. Or, you can click File to select a file using the file explorer
window of your Windows or Mac computer.



Select MP4 from the "Format" menu. If this option is not already selected, you need to select it now. This
ensures you can create MP4 files with the correct encoding (H.264).

Select the available installer from the menu. To make sure you choose the best settings for your video, first
look at the resolution and FPS next to "Source" at the top of the window. The higher the quality of the file, the
larger the capacity.

If you don't want to change the quality, simply choose a setting with the same (or close) resolution and frames
per second that you see in the source.

If you want to convert 4K WebM (4096x2034) files to 4K, select the Vimeo YouTube HQ 2160p60 4K
installer in the Web menu .



To reduce the size of high-quality videos, you should choose a lower resolution.

For example, if you want to reduce the size of an HD video with 1080p resolution and 60 frames per second
without greatly affecting the quality , you can choose one of the 720p30 settings .

The General installer is designed for use on any device, while the Web installer is used for sharing videos on
the internet.

For more details about all HandBrake presets, you can visit https://handbrake.fr/docs/en/latest/technical/official-
presets.html.

Select the save folder and name the file. Follow these steps to create an MP4 file:

Click Browse . You'll see this button next to "File" on Mac, and next to "Save As" on Windows computers.

Select the folder to save the file, and enter a new file name if necessary.

Click Save .

You will see the new file has the extension .m4vinstead of .m4a. However, don't worry, MP4 and M4V
formats are the same. This is the extension that makes the file compatible with QuickTime.

If you want to play videos using QuickTime Player on Mac, you need to keep the .m4v extension. Or, you'll
delete .m4vthe file name (next to "File" or "Save as") and replace it with .mp4.



Click Start Encode on a Windows computer or Start on a Mac. You'll see this option at the top of the
window. The file is immediately converted to MP4 format.

If you process large videos, this will take longer. With smaller videos, this only takes from a few seconds to a
few minutes.

When the conversion process is complete, the MP4 file will display in the folder you selected.

Use VLC Media Player (on Windows)



Open VLC Media Player on your Windows computer. VLC Media Player is a free video player that supports
playing any type of audio or video file. VLC also makes it easy to convert WebM files to other formats,
including MP4.

If you don't have VLC Media Player, you can download it from https://www.videolan.org.

If you want to reduce the quality of the output video, you're better off using Handbrake. You can use VLC to
change the quality, but Handbrake's simple presets let you skip setting up all the customizations manually -
which means you'll avoid creating new files. Low quality (or blurry) MP4 files.

Click the Media menu and select Convert/Save… (Convert/Save…). The Media menu is in the upper left
corner of VLC Media Player.



Click the Add button . You'll see this option near the top of the window.

Select the WEBM file and click Open . This is the operation of adding files to the upper part of the window.



Click the Convert/Save button . You'll see this option at the bottom of the window.

Select MP4 profile. Click the "Profile" menu, then select the Video - H.264 + MP3 (MP4) profile .



Click the button with the wrench icon. You'll see this option next to the "Profile" menu.

Select video encoding settings. To ensure the output video has the same settings as the original video, you
should select the following options:

Click the Video codec tab .

Select H-264 in the "Codec" menu.

Select Same as source in the "Frame Rate" menu.

Click the Resolution tab and make sure all options are set to Auto .



You can reduce the resolution if you like. However, increasing the resolution higher than the original video
resolution will not produce a good quality file.

Downscaling a low-resolution video will result in a poor quality file.

Click the Audio codec tab .

Check the boxes next to Audio and Keep original audio track .

Click Save .

Choose where to save the output file. Now you need to choose a folder on your computer to save the new file.
Proceed as follows:

Click Browse next to "Destination file".

Browse to the folder where you want to save the MP4 file.

In the "File name" field, you will replace .webmit with .mp4.

Click Save .



Click Start to convert video. You'll see this button at the bottom of the window. The WebM file is immediately
converted to MP4 format.

Processing may take a few minutes if the file is very large, but processing time will be shorter when the file is
smaller.

When the conversion is complete, you will see the new file in the selected folder.

Use VLC Media Player (on Mac)



Open VLC Media Player on Mac. VLC Media Player is a free program that supports playing any audio or
video file.

VLC also makes it easy to convert WebM files to other formats, including MP4. If you don't have VLC Media
Player, you can download it from https://www.videolan.org.

Click the File menu and choose Convert/Save… . The File menu is in the top left corner of the screen.

Open the file WebM. Proceed as follows:

Click the Open media… button .



Select the WebM file.

Click Open .

Select MP4 profile. If this option is not selected by default, you will click the "Choose Profile" menu and select
Video - H.264 + MP3 (MP4) .

Click the Customize… button . You'll see this option to the right of the selected profile.



Select H.264 video encoding. This is the operation to select the file conversion method for VLC. Proceed as
follows:

Click the Video codec tab .

Select H.264 from the "Codec" menu. This option may already be selected, otherwise you will choose from the
menu.

It's best to keep the default selections for the remaining options so that VLC uses the original ratio and resolution
for the output video.

You can reduce the resolution if you want, but increasing the parameters too much compared to the original
resolution will not produce a better quality file.

Scaling up a low-resolution video will result in a worse quality file.



Keep the original sound. Here's how to make sure your converted video still has sound:

Click the Audio codec tab .

Check the boxes next to "Audio" and "Keep original audio track".

Keep the default settings for the remaining options.

Click Apply . This saves your changes and returns you to the Convert & Stream window.



Choose where to save the file. Now you need to choose the folder to save the new file on Mac. Proceed as
follows:

Click Save as File under "Choose Destination."

Click the Browse… button that appears on the screen.

Find the folder where you want to save the MP4 file.

Enter a new name for the file in the "Save As" field above. You only need to enter a name for the file (such as
movie) and do not enter the ".mp4" extension.

Click Save .



Click Save to convert the file. This is the button at the bottom of the window. This will convert the WebM file
into MP4 format. This process may take a few minutes if the file is large, but will take less time if the file is
smaller.

Open the folder with the new file. You will see the new file has the extension .m4vinstead of .m4a. Don't
worry, though - the MP4 and M4V extensions are the same. The file has an extension compatible with Quick
Time.

If you want to play a video in QuickTime Player (the default video and audio player on Mac), you need to keep
the .m4v extension.



If you're not interested in QuickTime, you can easily rename the file to create a .mp4 extension and be able to
view the file in any video player that supports the MP4 format.

Rename the file (optional). If you want to add the .m4v extension to the file and don't mind watching videos in
QuickTime Player, you can easily follow these steps:

Click the file again to select it, and press Return .

Replace .m4vwith .mp4. For example, if the file is named movie.m4v, you would change it to movie.mp4.

Press Return .

Use Online Convert (on any platform)



Visit https://video.online-convert.com/convert-to-mp4 . Online Convert is a free web-based tool that allows
you to convert various files (including WEBM) into MP4 format.

This is a useful tool that helps you quickly convert small WebM files to MP4 without changing the output video.
If you want to process videos larger than 100MB, you'll need to try another method. Also, if you want to convert
more than 2 videos to MP4 format at the same time, upgrade to Premium plan or try another online converter.

Click Choose File . It's the white button on the green box.



Select the WebM file. Find and select the file with the ".webm" extension, and select Open or Upload when
prompted.

Click START . It's the green button below the file name. The conversion process immediately begins. Once the
conversion process is complete, you will see the option to download the MP4 file.



Save the downloaded file to your computer, phone or tablet. If the download doesn't start automatically, click
or tap Download . When asked, you need to choose where to save the file on your computer, Android, iPhone or
iPad, and click or tap Save to save the new MP4 file.

You finished reading the article "Convert WebM format videos to MP4 with VLC, Handbrake and online
conversion tools" edited by the TipsMake team. We hope this article has provided you with many useful tech
tips and tricks. You can search for similar articles on tips and guides. Thank you for reading and for following us
regularly.
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